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10 Steps to Getting Started with 
Restaurant Pro Express 

 

Your copy of Restaurant Pro Express (RPE) must be registered before use.   To register your software, 

choose Register from the File menu at the Login Screen.  Restaurant Pro Express will prompt you for your 

activation number; enter the serial number located on your RPE box.   

 

After entering your activation number, Restaurant Pro Express will access the pcAmerica registration 

server over the internet to register your software.   

 

NOTE:  The registration process requires an active internet connection.  If you do not have an internet 

connection, please contact your pcAmerica sales representative to manually register your software. 

 

For more information see step 2 of the 10 Steps to Getting Started section of the manual. 
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10 Steps to Getting Started 

Step 1 - Plug in the Equipment 

 

The first step of setting up your point of sale system is plugging in the equipment.   Some of the devices require hardware drivers 

which is what your computer uses to talk to each piece of equipment.   

Step by step instructions on how to plug in your new POS hardware, peripherals and install drivers are located at: 

 http://faq.pcAmerica.com/hardware  

        

 

 
 

 
   

Pole Display 
 
Your Pole Display allows 
customers to quickly and 
easily view their transaction 
as it is being entered into 
the system. 

Cash Drawer 
 
Store cash for the day in 
one safe and convenient 
place.  RPE features an 
antitheft setting to only 
allow employees to ring in a 
transaction with the cash 
drawer closed. 

Receipt Printer 
 
Receipt printers allow your 
customers to have an 
itemized breakdown of 
their transaction.  RPE will 
also enable you to place 
your company logo and 
bounce back coupon on the 
receipt. 

Kitchen Printer 
 
A kitchen printer is 
designed for speed.  Orders 
immediately print to the 
kitchen and food items can 
be designated to print at 
certain stations. 

 

 
For more detailed information about hardware and hardware configurations please see the Hardware Setup section of the 
manual. 

Note:  These are common connection arrangements.  Depending on the equipment you purchased, your connection 
arrangements will vary. 

 

http://faq.pcamerica.com/hardware
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10 Steps to Getting Started 

Step 2 - Install and Start Restaurant Pro Express 

 

Below are instructions on installing Restaurant Pro Express and starting it for the first time.   

You must be logged onto your computer as an Administrator with full access rights in order to properly install Restaurant 

Pro Express. 

 

If you have multiple stations within your store, it is very important that you install the server first!  We also recommend you read 

the Configure Multiple Stations section later in this manual.   

 

If you have multiple stores communicating to a corporate office, it is recommended you sign up for a pcAmerica training session 

to ensure you fully understand the process. 

 

1. Insert the Restaurant Pro Express CD into the CD-ROM drive.  Before 
installing RPE the installer will scan for any prerequisites.  Whatever 
is listed on this screen MUST be installed prior to the RPE install.  If 
nothing on this screen is installed you will get prompted to select ok 
to install everything. 

 

2. After all prerequisites have been installed the RPE installer should 
automatically launch and bring you to the next step.   

3. After the install has completed select Finish to exit the wizard. 

 

4. Select Next to begin the configuration process.  You will be asked a 
series of questions that will determine how your system is installed.  
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10 Steps to Getting Started 

Step 2 – Install and Start Restaurant Pro Express 

 

 

5. Restaurant Pro Express will prompt you to select your industry 
type, select A Retail Store.  Otherwise, choose A Corporate Office 
for a Chain of Stores or Restaurants ONLY IF this computer is an 
office computer in your corporate office (not an office computer in 
a retail store). 

 

6. The next screen in the wizard will be the Database Selection tab. 
 

 Select Configure This Computer to start a NEW database.  To 
connect to your server please see the Configure Multiple 
Stations section later in this manual for more information. 

 

7. You will need to answer a series of questions to help configure your 
system properly. 

 

8. If you are connecting more than one computer in your store to a 
server you must select the right server that station will be 
connecting to. 
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10 Steps to Getting Started 

Step 2 – Install and Start Restaurant Pro Express 

 

 

8. To setup a Store Server you will need to choose the appropriate 

Store ID by highlighting it.  In addition, you need to select a Station.  

For connecting a Station to a Store Server please see the Configure 

Multiple Stations section later in this manual. 

Note: Every station must have a unique number. 

 

9.  After you have configured your system select either Begin or Exit 

and restart the program. 

 

10.  In order to gain access to your new software you must now register 

it.  Select the Register Now tab and scan or enter the registration 

number that came with your software.  You must have an internet 

connection to register your software or call your customer service 

representative (1-800-722-6374 x278) to guide you through the manual 

registration process. 

 

11.  If you are not connecting to a corporate office, Restaurant Pro 

Express will proceed to the Login Screen after a brief loading process.  If 

you are connecting to a corporate office, you will be prompted for the 

corporate office information before progressing to the Login Screen. 

 

 

For a detailed installation guide please see the link below: 

 http://faq.pcamerica.com/maintenance/cre-rpe-installation  

http://faq.pcamerica.com/maintenance/cre-rpe-installation
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10 Steps to Getting Started 

Step 3 - Add Your Employees into the System 

 

Employees are configured within the Employee Maintenance screen of Restaurant Pro Express.  Cashiers and servers must be 

added into the system before they can log in and ring up sales.  Other types of employees can be added and their hours tracked 

within RPE, even if their jobs don’t require them to use the POS.  The steps below describe how to add your initial cashier into 

RPE; the Employee Maintenance section later in this manual will describe additional employee options, job codes and how to 

record employee hours. 

 
1. Select the Manager or Options button. 

2. Enter the administrator password (default: admin) where applicable.   
3. Select Administrative then, Employee Maintenance.  Only the administrator 

can access this screen. 

 

 

4. Select the Add Employee button to create a new employee record.  Assign a 
unique Employee ID (which could be their initials or some other unique 
identifier), password and a Display Name that prints on the receipt.  If you 
would like to assign a secure login card to this employee, swipe the card in the 
Card Swipe ID box. 

 

5. Assign security permissions by selecting the dropdown list and selecting Yes 
(the employee can do this), No (they cannot), Prompt (they can with manager’s 
permission) or Override (they can and are a manager for this function). 

 

For more information see the Top Five Employee Permissions and Uses section of 

the manual. 

 

6. Select the Save button.  Your employee has been added! Add any additional 
employees you wish to configure and then select the Exit button to go back to 
the Login Screen. 

 

For a detailed guide on adding and configuring employees in RPE please see the link below: 

 http://faq.pcamerica.com/software/employees/creating-employees 

http://faq.pcamerica.com/software/employees/creating-employees
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10 Steps to Getting Started 

Step 4 - Configure a Few Setup Options 

 
Restaurant Pro Express has hundreds of built-in features that can be turned on or off.  The Setup Screen includes many of these 
options, organizing them into multiple tabs.  You can access the Setup Screen from the Login Screen by selecting the File menu 
and Setup Screen – you must use the administrator password to enter this screen (default:  admin).  Global settings only need to 
be configured once for all stations while settings that are not global need to be configured once at each station.  Below is a chart 
of recommended feature settings: 
 

Feature Tab Quick Service 
Restaurant 

Quick Service 
Restaurant 

Global 

Prompt Cashier ID, requires a cashier to login for 

every check. 

Invoice Settings X   

Change the Receipt Size to Short Receipt to print 

only the most important information. 

Receipt X X  

Enter the company information that prints on the 

receipt. 

Company Info X X X 

Enter necessary credit card information if you are 

processing credit cards through Restaurant Pro 

Express. 

Payment Processing X X  

Prompt Table option will either prompt for a table 

layout after logging in or go straight to the 

invoicing screen. 

Restaurant Features -> 

Functionality 

X X  

Create text that will print on the bottom of a 

receipt as a coupon. 

Couponing X   

On Hold ID will allow you to choose how the On 

Hold ID is handled with Restaurant Pro Express. 

Restaurant Features -> 

Functionality 

X X  

Reason Codes allow you to choose a reason why 

you are accepting a return. 

Invoice Settings X X X 

Combine lines items scanned multiple times will 

appear on the same line item. 

Invoice Settings X X  

 

You can read about the other settings and options in the Setup Screen in our F1 Help Section built into Restaurant Pro Express.  
You can also get detailed information about the setup screen from the link below: 

 http://faq.pcamerica.com/file-lockers/pdf-locker/Setup_Screen.pdf  

 

http://faq.pcamerica.com/file-lockers/pdf-locker/Setup_Screen.pdf
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10 Steps to Getting Started 

Step 5 - Create Your Inventory Items 

 

Your goods are separated into groups called Departments.  A few examples of departments are Appetizers, Desserts, Pastas and 

Value Meals.  Departments are used to organize your menu items on the screen and also to report on your items.  After your 

departments are created, you may create menu items inside of each of your departments. 

 

To begin creating your inventory list, select the Manager Button on the top right of the Login Screen and enter a username and 

password (default username: 01, password: admin).  Navigate to the Inventory Maintenance screen inside of the Administrative 

tab. 

 

 

To add a new department, select the blue Department for this Item 

link in the top left of the screen.  This will bring you to the 

Department Maintenance screen. 

 

Select the Add Department button, type in a department ID (ex: SMTH) and description (ex: Smoothies) and select Save.  After 

adding the department, select Exit to return to the Inventory Maintenance screen. 
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10 Steps to Getting Started 

Step 5 – Create Your Inventory Items 

 

To add a new item, select the Add Item button on the bottom of the Inventory Maintenance screen.  The required information is 

on the top one-third of the screen: 

 The Department this item will be inside of (ex: Smoothies). 

 A unique Item Number (ex: SW1001, or the barcode of the item). 

 A Description, which will print on the receipts (ex: short sleeve v-neck). 

 Your Cost, which is the price you pay. 

 The Price you charge the customer. 

 An optional # In Stock value if you track stock levels. 

 Various tax options can be selected, if you charge tax for this item. 
 

 

 

Select the Save button and the item will now be added to your inventory list.  See the next step to change the default format of 

your button and customize the touchscreen with your own colors. 

TIP:  Most restaurants apply modifiers (such as meat temperatures, toppings, side dishes, etc.) to their items.  See the 

following document for information on how to configure modifiers: 

 http://faq.pcamerica.com/file-lockers/pdf-locker/Creating_modifiers.pdf  

 

For a complete breakdown of all options in Inventory Maintenance please see the document below: 

 http://faq.pcamerica.com/file-lockers/pdf-locker/Inventory_Maintenance_Screen.pdf  

 

For detailed instructions on adding inventory please see the link below: 

 http://faq.pcamerica.com/software/inventory/creating-new-inventory-items  

 

  

http://faq.pcamerica.com/file-lockers/pdf-locker/Creating_modifiers.pdf
http://faq.pcamerica.com/file-lockers/pdf-locker/Inventory_Maintenance_Screen.pdf
http://faq.pcamerica.com/software/inventory/creating-new-inventory-items
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10 Steps to Getting Started 

Step 6 – Configure Your Inventory and Function Buttons 

 

The menu screen where you place your orders is a highly customizable screen.  By default, menu items are displayed in the order 

you add them.  The buttons are a default color and their configuration can be changed easily.   

 

To change the look of your menu, and configure function buttons and best sellers, select the Manager Button on the top right of 

the Login Screen and enter a username and password (default username: 01, password: admin).  Next select the Setup tab and 

then Touch Screen Configuration.    

 

The General tab is used to configure the custom quick buttons on the bottom of the screen.  To 

assign a function or a best seller to a custom button, select the button on the screen (it will 

highlight in green), choose the function from the Select this button’s function dropdown and 

fill in the information beneath.  Make sure to check Display this Button to display it on the 

screen.  A popular use for a function button is for best sellers, which is a menu button that will 

be on the screen no matter what department you are in.   To assign one, choose the function 

Fixed Item and fill in the item number in the box below.   

 

The functions in the Items & Departments tab are used to change the order, color, caption and 

picture of your menu buttons.  You can also choose to make certain items or departments 

invisible.  

 To change the color of a department or menu item button, select the department (in the 
left list) or menu item (in the right list) and choose the Select Color button. 

 Change the order of your departments or menu items by selecting them from the list and 
using the Up or Down buttons. 

 

When you are finished making changes, select the Save & Exit button.  Your saved changes will 

display the next time you log into the menu screen. 

 

TIP:  Changes made to the menu on one terminal automatically update ALL terminals in real time.  You do have the ability to 

design different menus for specific terminals in your restaurant without affecting the other terminals.  For example, restaurants 

with a bar commonly have a different menu layout at the bar than at the rest of the restaurant.  To do this, select the Configure 

This Station Individually menu option from the Options menu on the top of the screen.   

If this is checked, any layout changes made within Touch Screen Configuration will not affect other terminals. 

For a detailed guide on using the touch screen configuration window please see the link below: 

 http://faq.pcamerica.com/file-lockers/pdf-locker/Touch_Screen_Configuration.pdf  

 
  

http://faq.pcamerica.com/file-lockers/pdf-locker/Touch_Screen_Configuration.pdf
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10 Steps to Getting Started 

Step 7 - Login to the System 

 

Servers must login to Restaurant Pro Express before they can ring up customers or enter orders.  The Login Screen prompts 

servers for a user name and password, or alternatively the server can swipe their employee card to gain access.  

 

 

1. To log into RPE, simply enter your ID and password 
(default for the demo is “01” and “admin”), enter the 
employees id or swipe the secure login card you 
configured in the Employee Maintenance screen.   

 

If you are a QSR and not using the table service features 

of RPE, you will go immediately into the restaurant menu 

screen. Otherwise, you will proceed to number two 

below. 

 

2. If your establishment is a table service restaurant, select 
the table.  Your table layout can be configured to 
resemble your restaurant, with tables organized in 
different sections (ex: dining room, patio, bar) and 
options to vary shapes and sizes.  Select the Edit Layout 
to modify your table layout from any station.  Please 
refer to the Laying Out Your Tables for Fine Dining and 
Table Service section for instructions on configuring your 
tables. 

 

 

 

A secure login card helps prevent one server from logging in as a 
different server (which is a hole for theft). Without a secure login 
card, servers must type in a user name and password, which is 
visible to others close by. The only way to log in with the card is to 
swipe the card, protecting the server’s drawer from others trying 
to steal money.  You can purchase these cards from pcAmerica. 
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10 Steps to Getting Started 

Step 8 - Ring in Some Items 

 

Ringing up items is easy.  Simply select the department the item is in (examples: appetizers, entrees, desserts, pastas, etc) and 

select the menu items to add to the check. If the item has modifiers that apply to it (such as a meat temperature for a burger) RPE 

will prompt the server to make the choices and then add the item to the check. 

 
 

TIP:  For table service restaurants, Restaurant Pro Express does allow you to assign each item ordered to the guest 

ordering it, using the Order by Guest features.  The guest number for each item will print in the kitchen so the runner 

knows which guest ordered which menu items and doesn’t have to “auction off food.”  For help turning on this feature, 

please refer to the F1 Help Section. 

 

For detailed instructions on invoicing in Restaurant Pro Express please see the link below: 

 http://faq.pcamerica.com/software/invoicing/invoicing-in-restaurant-pro-express  

 
  

http://faq.pcamerica.com/software/invoicing/invoicing-in-restaurant-pro-express
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10 Steps to Getting Started 

Step 9 – A Few Basic Every Day Functions 

 
You can access additional functions by selecting an item on the menu grid.  Below is an explanation of 
each of these buttons. 
 

 

 

 

To delete one or more items, select the items (which will highlight them) and select the 

Delete button.  This function can be limited using employee permissions. 

To apply a discount to one or more items, select the items (which will highlight them) and 

select the Line Discount % button.  You will be prompted by a discount percentage.  This 

function can be limited using employee permissions. 

If you would like to order more than one item, you can select the item and select the Change 

Quantity button.  An alternate way of doing this is just selecting the menu item button 

multiple times.  This function can be limited using employee permissions. 

Modify is used to modify the modifiers that are already on an item.  This function can be 

limited using employee permissions. 

Reorder Round is commonly used in a restaurant or bar where many people want to reorder 

the same item they previously drank.  Select the items you’d like to order and select Reorder 

Round, which will up the quantity by one.  This function can be limited using employee 

permissions. 

Transfer is used to transfer this check to a different table.  This function can be limited using 

employee permissions. 

Select the Show Menu button to deselect all the items you’ve selected in the menu grid and 

go back to the menu buttons. 
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10 Steps to Getting Started 

Step 10 - Complete the Transaction 

 

Step 10 is the most important part of the transaction – accepting tender (money).  The three most common forms of payment in 

most restaurants are cash, credit\debit cards and gift cards. 

 

To PAY for a transaction, select the PAY button.  This will bring up the amount tendered screen where you 

can pay using one or more payment methods. 

 

 

Restaurant Pro Express’ amount tendered screen is built for speed and 
flexibility.  The default amount is always the exact amount remaining.  To 
enter a payment, touch in the amount and select the payment method.  
If paying by gift card, credit\debit card or check, RPE will ask you for 
more information.  You can also enable one-touch quick payment 
buttons for the most common tender amounts.  RPE supports split 
tendering, meaning you can pay with more than one tender.  

 

 

To put a check on hold (for table service, or quick service where you pay at a separate 

counter), use the CHECK or SEND button.  The check is then put on hold waiting for 

more items to be added or for the customer to finish their meal and pay their bill.  See 

below for a more detailed description of these functions. 

CHECK is used to print a copy of the invoice locally at your receipt printer to give to your customer (if they would like to 

see what they ordered). 

SEND is used to send items that have been ordered to a kitchen printer (if applicable) to have your kitchen staff, prepare 

the ordered items. 
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10 Steps to Getting Started 

Step 10 - Complete the Transaction 

 

 

In table service restaurants, some parties will ask for separate checks.  To split a check the 

server can select EDITS and then SPLIT CHECK.   

   

Inside of the split checks screen you can split evenly (example split 3 ways), split by guest (if using the 

order by guest feature) or select and drop items amongst different split check in any fashion you wish. 

 

 

 

 

Congratulations!  You’ve rung up your first sale inside of Restaurant Pro Express.  You’ve covered the 

basics and can now use your new point of sale system.  The remainder of this manual includes some 

useful information for configuring and using your Restaurant Pro Express point of sale system. 

 


